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cana @B Copy

HAT IS

WHAT IS «ACANA @BCOPY» ?

«Acana@bCopy» copies the address of a contact to the clipboard.
«Acana@bCopy» has these features:

GANA e Copies the address of a contact to the clipboard

e Copies the address of all contacts to the clipboard

B UPY? e Copies the address of all selected contacts to the clipboard
e Address either with company/department

e Name optionally with title

e Share contact (Twitter, Facebook, etc)

e Drag and Drop address to any application

¢ Export contacts as CSV file

e Export selected contacts as CSV file

e Export contact as Excel® XLSX file

e Export selected contacts as Excel® XLSX file
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START APPLICATION

After the start of «Acana @b Copy» you see all entries of the macOS address book.

| XN Acgana @b Copy
= el = « Apple
ExpﬁLSX Exploﬁ?lsv CcEwSisall CopyEsEeE:I-:;ected %%a% Use'person = L Search e
Street ZIP City Company Department Prefix  Country State
GroOe Bockenheimer St... 60313 Frankfurt Apple Retail Store GroBe Bockenheimer St... Germany
Willy-Brandt-Platz 1 86153 Augsburg Apple Retail Store City-Galerie Augsburg Germany
Aachener StraBe 1253 50858 Kdln Apple Retail Store Rhein Center Germany
Altmarkt 25 01067 Dresden Apple Retail Store Altmarkt-Galerie Germany
Hirschgebouw, Leidsepl... 1017 PS Amster... Apple Retail Store Amsterdam Netherlands
320 West 5th Avenue 99501 Anchorage Apple Retail Store Anchorage 5th Avenue ... U.S.A. AK
Alstertal-Einkaufzentrum 22391 Hamburg Apple Retail Store Alstertal Germany
17711 Chenal Parkway 72223 Little Rock  Apple Retail Store The Promenade at Che... U.S.A. AR
Via Curiel, 25 20089 Milano Roz... Apple Retail Store Fiordaliso Italy
1981 Broadway 10023 New York Apple Retail Store Upper West Side U.S.A. NY
367 George Street 2000 Sydney NSW Apple Retail Store Sydney Australia
320 The Bridge Street 35806  Huntsville Apple Retail Store Bridge Stree U.S.A. AL
Bahnhofstrasse 77 8001 Zirich Apple Retail Store BahnhofstraBe Switzerland
ArnulfstraBe 19 80335 Minchen Apple GmbH Germany
701 West Georgia Street V7Y IGS Vancouver Apple Retail Store Pacific Center Canada British Columbia
One Stockton Street San Franci... San Francisco

94108

Apple Retail Store

U.S.A.

Table of contents
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cana @B Copy

PERATION UF

CANA
BL,OPY

OPERATION OF «kACANA@BCOPY»

In the main window of «Agana @b Copy» the contact from the macQOS are in the middle. Several
functions are available in the upper area. At the bottom you got messages from the application.
At the bottom right you see the number of all address book contacts from macOS.

@ Agana @b Copy
E B % =5 ~
XLSX Ee

csv Ii-l E 2

Export XL5X Export CSV Copy all Copy selected Reload hare... Lise parson Search

Last First Street City Company ~ Department

Acana@BCopy

© 2013-2024 CIMSoft,@pps4Me

Table of contents

Altmarkt 25

One Stockton Street
Aachener StraBe 1253
Centroallee 147
Bahnhofstrasse 77

GroQe Bockenheimer St...

1981 Broadway

Via Curiel, 25
Alstertal-Einkaufzentrum
320 West 5th Avenue
701 West Georgia Street
Passeig de Postosi, 2
17711 Chenal Parkway
1685 Briargate Parkway

Hirschgebouw, Leidsepl

67
84108
50858
48047
8001
60213
10023
20089
22391
89501
V7Y IGS
08030
72223

Dresden
San Franci...
Kdin
Oberhausen
Zirich
Frankfurt
MNew York

Milano Roz...

Harmburg

Anchorage
Vancouver
Barcelona
Little Rock

Colorado S...

Amster...

Apple Retail Store
Apple Retail Store
Apple Retail Store
Apple Retail Store
Apple Retail Store
Apple Retail Store
Apple Retail Store
Apple Retail Store
Apple Retail Store
Apple Retail Store
Apple Retail Store
Apple Retail Store
Apple Retail Store
Apple Retail Store
Apple Retail Store
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Altmarkt-Galerie
San Francisco
Rhein Center
CentrO
BahnhofstraBe

GroBe Bockenheimer St...

Upper West Side
Fiordaliso
Alstertal
Anchorage 5th Avenue ...
Pacific Center
La Maguinistra
The Promenade at Che...
The Promenade Shops ...

Amsterdam




cana @B Copy

TOUCH BAR

UUCH AR If your Mac has a touch bar, you can use these features:

Export all data as Excel® XLSX file

Export all data as CSV file
===z Copy all data

=== Copy selected data

Reload address book
Copy private data

Copy company data

csv
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cana @B Copy

OPY

COPY A CONTACT TO CLIPBOARD

To copy a contact to the clipboard, select one with a double click.

| NN Acana @b Copy
U N TACT 0 = — O - Q- Apple (>
Exp%LSX Exploﬁ?lsv C:;Tall Copy=;<;|=ected fﬁﬁ Use'pe?son Search
Street ZIP City Company Department Prefix Country State
LI PB UA R D GroOe Bockenheimer St... 60313 Frankfurt Apple Retail Store GroBe Bockenheimer St... Germany
Willy-Brandt-Platz 1 86153 Augsburg Apple Retail Store City-Galerie Augsburg Germany
Aachener StrafBBe 1253 50858 Koln Apple Retail Store Rhein Center Germany
Altmarkt 25 01067 Dresden Apple Retail Store Altmarkt-Galerie Germany
Hirschgebouw, Leidsepl... 1017 PS Amster... Apple Retail Store Amsterdam Netherlands
320 West 5th Avenue 99501 Anchorage  Apple Retail Store Anchorage 5th Avenue ... U.S.A. AK
Alstertal-Einkaufzentrum 22391 Hamburg Apple Retail Store Alstertal Germany

Via Curiel, 25 20089 Milano Roz... Apple Retail Store Fiordaliso Italy

1981 Broadway 10023 New York Apple Retail Store Upper West Side U.S.A. NY

367 George Street 2000 Sydney NSW Apple Retail Store Sydney Australia

320 The Bridge Street 35806 Huntsville Apple Retail Store Bridge Stree U.S.A. AL
Bahnhofstrasse 77 8001 Zirich Apple Retail Store BahnhofstraBe Switzerland

ArnulfstraBe 19 80335 Minchen Apple GmbH Germany

701 West Georgia Street V7Y IGS Vancouver  Apple Retail Store Pacific Center Canada British Columbia
One Stockton Street 94108 San Franci... San Francisco U.S.A.

Apple Retail Store

You can see a message at the left bottom of the main window, that the selected contact was
copied to the clipboard.
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cana @B Copy

OPY

LL LONTACTS
|

LIPBOARD
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COPY ALL CONTACTS TO CLIPBOARD

To copy all contacts to the clipboard, click on the icon ,Copy all”.

| XN Acgana @b Copy

Export XLSX Export CSV  Copyall Copy selected Relad Use person  Share

Q- Apple

Search

Table of contents

After this, you can paste the contacts in any other application. In Microsoft® Excel® and Apple®

Numbers® all data are filed in separate fields.

0 @ M A S d = & = Mappe1
Start Einfligen Zeichnen Seitenlayout Formeln Daten
L. Umbruchvorsehau - 4 7a0m | 120% =
1 Seitenlayout -
Standard I'_' Banutzerdefinierte Ansichten Sneeigen El TR ate a0
HY - fx
£ D E
1 StraBe PLZ Stadt
2 | One Stockton Street 94108 San Francisco, CA
3 | Via Curiel, 25 20089 Milano Rozzano
4 320 The Bridge Street 35806 Huntsville
5  Jungfernstieg 12 20354 Hamburg
6 | 1-20-9 linnan, Shibuya-ku 150-0041 Tokyo
7 /1981 Broadway 10023 New York
g | Altmarkt 25 1067 Dresden
9 | Alstertal-Einkaufzentrum 22391 Hamburg
10  Bahnhofstrasse 77 8001 Ziirich

Uberpriifen
— =m e A
| | |
Fenstar Makros Makro
anzeigen aufzeichnen
F
Firma

Apple Retail Store
Apple Retail Store
Apple Retail Store
Apple Retail Store
Apple Retail Store
Apple Retail Store
Apple Retail Store
Apple Retail Store
Apple Retail Store
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Abteilung

San Francisco
Fiordaliso
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Jungfernstieg
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OPY
ELECTED
ONTACTS
|
LIPBOARD
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COPY SELECTED CONTACTS TO
CLIPBOARD

To copy all selected contacts to the clipboard, click on the icon ,Copy selected”.
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| XN Acgana @b Copy
==== m——— ==== §FF i . _ I
=== =zz= A B [M] Q- Apple (>
[ CSV | Hemb TEER N pommi ==
Export XLSX Export CSV  Copy all Copy selected Reload Use person Share Search

After this, you can paste the contacts in any other application. In Microsoft® Excel® and Apple®
Numbers® all data are filed in separate fields.

59 M Ad ©-¢ = s Mappel \~ Im Blatt suchen @-
Start Einfligen Zeichnen Seitenlayout Formeln Daten Uberpriifen =t Freigeben ~
Lo Umbruchversehau v ¥ Zaom | 120% = — E—in. .I..—in.
7 Seitenlayout - | == -
Standard I'_' Benutzerdefinierte Ansichten el ,‘a‘ EodnmARe 19 0E Fenster a:'-,q::,-;ﬂ;n aurr:;lg;aﬂﬂﬂ
H9 8 fx 4
£ E F G
1  StraBe PLZ Stadt Firma Abteilung
2 | One Stockton Street 94108 San Francisco, CA Apple Retail Store San Francisco
3 Via Curiel, 25 20089 Milano Rozzano Apple Retail Store Fiordaliso
4 320 The Bridge Street 35806 Huntsville Apple Retail Store Bridge Stree
5  Jungfernstieg 12 20354 Hamburg Apple Retail Store Jungfernstieg
6 | 1-20-9 linnan, Shibuya-ku 150-0041 Tokyo Apple Retail Store Shibuya
7 | 1981 Broadway 10023 New York Apple Retail Store Upper West Side
8  Altmarkt 25 1067 Dresden Apple Retail Store Altmarkt-Galerie
9 | Alstertal-Einkaufzentrum 22391 Hamburg Apple Retail Store Alstertal
10 Bahnhofstrasse 77 8001 Ziirich Apple Retail Store Bahnhofstrale
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DRAG AND DROP A CONTACT

You can easy ,Drag and Drop” a contact from «Acana @b Copy» into any other application
(Pages®, Numbers®, Excel®, Word®, Libre Office®, Textedit, E-Mail etc.).

| XN Acana @b Copy
= E [ & [0 Qv Apple o
Exp%LSX Explo?:SV C;;Tall Copy-s:e-l-ected gjégg Us;peison Share Search
Street ZIP City Company Department Prefix  Country State
GroOe Bockenheimer St... 60313 Frankfurt Apple Retail Store GroBe Bockenheimer St... Germany
Willy-Brandt-Platz 1 86153 Augsburg Apple Retail Store City-Galerie Augsburg Germany
Aachener Strafe 1253 50858 KoIn Apple Retail Store Rhein Center Germany
Altmarkt 25 01067 Dresden Apple Retail Store Altmarkt-Galerie Germany
Hirschgebouw, Leidsepl... 1017 PS Amster... Apple Retail Stoje Amsterdam Netherlands
320 West 5th Avenue 99501 Anchorage Apple Retail Store Anchorage 5th Avenue ... U.S.A. AK

Alstertal-Einkaufzentrum

22391

Hamburg

Alstertal

Germany

Via Curiel, 25 20089 Milano Roz... Apple Retgil Store Fiordaliso Italy

1981 Broadway 10023 New York Apple Rgtail Store Upper West Side U.S.A. NY

367 George Street 2000 Sydney NSW etail Store Sydney Australia

320 The Bridge Street 35806  Huntsville Retail Store Bridge Stree U.S.A. AL
Bahnhofstrasse 77 8001 Zirich BahnhofstralBe Switzerland

ArnulfstraBe 19 80335 Minchen Apple GmbH Germany

701 West Georgia Street V7Y IGS Vancouver Apple Retail Store Pacific Center Canada British Columbia
One Stockton Street 94108 San Franci... San Francisco U.S.A.

'Apple Retail Store

@

56 Contacts

Untitled — ~

= (Untitled)

Apple Retail Store
Alstertal

i

Alstertal-Einkaufzentrum
Hamburg 22391
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SHARE A CONTACT

cana @B Copy
You can share a contact to all on your system available sharing services. Select a contact and click

HARE -
ONTAGT cljln-l e sharing icon.

@ @ Acana @b Copy
" = = = fo] & |
E=E= E=E= A = 2 ~ Apple )
==== £222 s --2 I-_-l £ Mail s
Export XLSX Export CSV  Copy all Copy selected Reload Use person Share Search
s Messages
Street ZIP City Company Country State
.~ Notes
\ g :
GroOe Bockenheimer St... 60313 Frankfurt Apple Retail Store s Tot ‘k Germany
| (o]
Willy-Brandt-Platz 1 86153 Augsburg Apple Retail Store | - . Germany
‘ Reminders
Aachener Stral3e 1253 50858 Koéln Apple Retail Store Germany
Altmarkt 25 01067 Dresden Apple Retail Store | Germany
Hirschgebouw, Leidsepl... 1017 PS Amster... Apple Retail Store X support@%ﬁ.ﬁ%%ﬁ&}?@ Netherlands
320 West 5th Avenue 99501 Anchorage  Apple Retail Store B i ek p.S.A. AK
Alstertal-Einkaufzentrum 22391 Hamburg Apple Retail Store Germany
| 7MChenalParkway 72223 LitdoRock AppleRetststore |~ T bsa oA
Via Curiel, 25 20089 Milano Roz... Apple Retail Store Fiordaliso Italy
1981 Broadway 10023 New York Apple Retail Store Upper West Side U.S.A. NY

@ OneNote

17711 Chenal Parkway

72223 Little Rock

Created with: Agana @b Copy
https://goo.gl/igxYGq
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¥ Notizbuch von Horst » Schnelle Notizen Cancel
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WITCH L, 0PY
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SWITCH COPY FEATURE

As default the private address is copied. You can switch this to the company data. Click on the
icon ,Use person” to switch on ,Copy company/department”. The icon will change its image and
color.

= b

| XN Acana @b Copy
siEs Sk === o _ ]
FEn Gm = HE (9 ®:  [] bt 2
Export XLSX Export CSV  Copy all Copy selected Reload Use person Share Search

If you click twice on the icon, the symbol shows the normal image in white color.

Table of contents © 2013-2024 CIMSoft, @ppsd4Me Page 13




cana @B Copy

ILTER
ONTACTS

FILTER CONTACTS

The list of contacts can be filtered by entering a search text. The search will be done on all
available fields.

e Name

First name
Street

ZIP Code
City

e Company
e Department
o Title
e Country
| XN Agana @b Copy
mma 5 '@ ‘I‘
e = Q- Apple I
Xcsx (G5 : oy w1 e
Export XLSX Export CSV  Copyall Copy selected Reload Use person Share Search
Street ZIP City Company Department State
GroOe Bockenheimer St... 60313 Frankfurt Apple Retail Store GroBe Bockenheimer St...
Willy-Brandt-Platz 1 86153 Augsburg Apple Retail Store City-Galerie Augsburg
Aachener StraBe 1253 50858 KdIn Apple Retail Store Rhein Center
Altmarkt 25 01067 Dresden Apple Retail Store Altmarkt-Galerie
Hirschgebouw, Leidsepl... 1017 PS Amster... Apple Retail Store Amsterdam
o 320 West 5th Avenue 99501 Anchorage  Apple Retail Store Anchorage 5th Avenue ... AK
=8 Alstertal-Einkaufzentrum 22391 Hamburg Apple Retail Store Alstertal Germany
3 17711 Chenal Parkway 72223 Little Rock  Apple Retail Store The Promenade at Che... U.S.A. AR
g} Via Curiel, 25 20089 Milano Roz... Apple Retail Store Fiordaliso Italy
o 1981 Broadway 10023 New York Apple Retail Store Upper West Side U.S.A. NY
E 367 George Street 2000 Sydney NSW Apple Retail Store Sydney Australia
&J" 320 The Bridge Street 35806 Huntsville Apple Retail Store Bridge Stree U.S.A. AL
Bahnhofstrasse 77 8001 Zirich Apple Retail Store BahnhofstraBe Switzerland
ArnulfstraBe 19 80335 Miinchen Apple GmbH Germany
701 West Georgia Street V7Y IGS Vancouver  Apple Retail Store Pacific Center Canada British Columbia
San Franci...

© 2013-2024 CIMSoft,@pps4Me

56 Contacts

One Stockton Street

94108

Apple Retail Store

San Francisco U.S.A.
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cana @B Copy
RELOAD ADDRESS

ELUAD The macOS can be easily reloaded. Click on the reload icon.

DDRESS

| XN Acana @b Copy

giss @ a_ |
[XLsX] (csV] === === o m: ]
Export XLSX Export CSV  Copyall Copy selected Reload Use person Share

BOOK

Q- Apple

Search
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cana @B Copy

XPORT A4S
LSX I"ILE

EXPORT AS XLSX FILE

You can export the contacts as a Excel® XLSX file. Click on the icon ,XLSX" in the toolbar menu
and choose one of these export features.

@ @ Acana @b Copy
Zz== S==g 94 = | | Q~ Apple )
[XLSX ] (CSV | EE=S =222 S .-;
Export XLSX Export CSV  Copy all Copy selected Reload Use person Share Search

Select ,File => Export..."” from the menu and choose one of these export features

@ @ Acana @b Copy
= E E E B & I Q- Apple )
Exp ==== Reload Use person Share Search
Si Elg-ﬂ \ Company Department Prefix  Country State
= Export visible entries as XLSX file |
Gi WIED \pple Retail Store GroBe Bockenheimer St... Germany
W a Export selected entries as XLSX file :\pple Retail Store City-Galerie Augsburg Germany
R St Apple Retail Store Rhein Center Germany
Altmarkt 25 01067 Dresden Apple Retail Store Altmarkt-Galerie Germany
Hirschgebouw, Leidsepl... 1017 PS Amster... Apple Retail Store Amsterdam Netherlands

The export feature is also available via the "Menu => File”.

o Export visible entries as XLSX file
o EXport selected entries as XLSX file
= Export all entries as CSV file

=u Export visible entries as CSV file
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=u EXport selected entries as CSV file

© 2013-2024 CIMSoft,@pps4Me
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cana @B Copy

EXPORT AS CSV FILE

XPURT S You can export the contacts as a CSV file. Click on the icon ,CSV" in the toolbar menu and

choose one of these export features.

csv
& @ Acana @b Copy
z=n zaEn ~ @ ‘I
z=m= e red = Q~ Apple {x]
[ XLSX) | CSV | ESES =SEE N | '-; U PP
Export XLSX Export CSV  Copy all Copy selected Reload Use person Share Search
| XN Acana @b Copy
; Iz - & ]
ieioin] Z=== ===x = Q~ Apple [ ]
[XL5x] g = 3 - °p
Export XLSX Exj [ zz== e person  Share Search
Street \ Department Prefix Country State
555 Export visible entries as CSV file
GroOe Bockenhg = itore Grof3e Bockenheimer St... Germany
Willy-Brandt-Pl: == Export selected entries as CSV file itore City-Galerie Augsburg Germany
Aachener StraBe cww. e e S Rhein Center Germany
Altmarkt 25 01067 Dresden Apple Retail Store Altmarkt-Galerie Germany
Hirschgebouw, Leidsepl... 1017 PS Amster... Apple Retail Store Amsterdam Netherlands
320 West 5th Avenue 99501 Anchorage Apple Retail Store Anchorage 5th Avenue ... US.A. AK

Select ,File => Export..."” from the menu and choose one of these export features

= EXport all entries as XLSX file
o EXport visible entries as XLSX file
m

- Export selected entries as XLSX file

=u EXport visible entries as CSV file

=u Export selected entries as CSV file
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Select the fields that should be exported.

cana @B Copy
Available Fields Export Fields

XPORT /\S
SV FILE -

Street

ZIP

City
Company
Department
Prefix
Country
State

Export all fields -> <- Remove all fields

Export Parameter

Field Separator

r WV

Text Recognition Sign
None .4 With Headline

Cancel

A single field can be moved by ,Drag and Drop” into the list of export fields.

If you would export all fields, click on ,Export all fields ->”. You can also move a single field from
the list of export fields back into the list of available fields. You can move all field back to the list
of available fields with a click on ,<- Remove all fields".
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cana @B Copy
Set the parameters (Field separator, text recognition sign and headline) for the export file and

XPURT S click on ,Export as CSV".

Available Fields Export Fields
SV FILE
First
Street
ZIP
City
Company | ’ "
Department 0
Prefix

Country
State

Export all fields -> <- Remove all fields

Export Parameter

Field Separator

; &

Text Recognition Sign

None 2 With Headline

Cancel

>
o
(=]
L9
o0
®
o
c
]
L
<

©:2013-2024 ClMSOﬁI,@ppS4M€ Table of contents © 2013-2024 ClMSO'&, @pps4Me Page 19




cana @B Copy

PREFERENCES

REFERENCES In the preferences you can define which data should be copied. You can also swap the City/ZIP

code automatically. To do this, activate the switch ,Swap City/ZIP". This will copy the address like
,Los Angeles CA, 80095". If the switch is deactivated, it will copy the address in normal way like
,20191 Hamburg”.

Copy Prefix
L4 Copy Company
Copy state

Swap City/ZIP
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cana @B Copy

ELP (VIENU

HELP MENU

With the menu <Help> you can select these functions.

O Acana ABCopy Help
New in this release

A Open @pps4Me homepage

A; Privacy Policy

A Product information

A; @pps4Me News

A1 Rate on AppStore

m More apps from AppStore

] Share >

<] Question about the application
< Feature Request
><] Report Problem

>
o
(=]
L9
o0
®
o
c
]
L
<

©:2013-2024 ClMSOﬁI,@ppS4M€ Table of contents © 2013-2024 ClMSO'&, @pps4Me Page 21




SHARE A LINK TO THIS APP

cana @B Copy
HARE To share a link to this app with your friends on email, messages, twitter®, Facebook® or AirDrop
use the menu "Help => Share a link to this app on...". You can also like us on Facebook or follow

INK 0 us on twitter.
H IS PP ) Acana ABCopy Help
New in this release

A Open @pps4Me homepage
A Privacy Policy
A Product information
A; @pps4Me News
7.5 Rate on AppStore
/4% More apps from AppStore
~ Share > _' X Share «Agana @b Copy» on X

f Share «Acana @b Copy» on Facebook
<] Question about the application ¢ i

<] Feature Request X Follow @pps4Me on X
><] Report Problem f Like @pps4Me on Facebook
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ROM
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MORE APPS FROM @PPSAME

Click here for more apps from @pps4Me.
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CONTACT TO US

UNTAGT If you still have unanswered questions, please send us an e-mail at Contact@Support. Or visit our

Homepage.
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COPYRIGHT & GENERAL TERMS AND
CONDITIONS

General Terms and conditions for the use of this help book.
I. Right-holders, copying, Copyright

1. The copyright of this help book is by CIMSoft, pps4Me, Horst Jehle, Grazer Street 17a, 70469
Stuttgart (hereinafter referred to as "author"). The Copyright refers to the graphics, the text as
well as the electronic source text to graphics and all texts as a whole.

2. In the source text of the template (template) is the copyright of the author. This Copyright
notice © in the source text of the manual must not be removed. Already the removal of copyright
constitutes copyright infringement and may be punishable by law.

Add your own copyright notice is not permitted.

3. The provision of this manual with download option on their own or third party websites, the
reproduction and copying to CD's/DVD's or other data carriers for the purpose of disclosure to
third parties both paid and free of charge (except for personal use) as well as a direct link to the
download files is prohibited.

4. With the download of this manual, the user acknowledges the terms and conditions of use.
Il. Free private use
1. This help book is free to personal, private, non-commercial purposes.

2. With the download of this manual, the user receives the right to use the manual for the
purposes of this Terms of use. The property rights in the content fully remain with the author.

lll. Commercial pay use

1. Commercial and thus pay use for the purposes of this Terms of use is when to book a private
or third acquisition business regardless of the size advertised in any way, pay services under a
single URL provided.
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IV. Scope of the commercial use

1. The use of this help book is only permitted for a company. The right of use expires with the
use at another company or a subsidiary or parent company. The right of use is each registered
Company to acquire new or pending business.

2. With every purchase of the manual is the internet address (URL) under the manual goes online

3. For any use in accordance with Section |V of the terms of use is a one-time fee for usage
numbers. The amount of the remuneration of utilisation can be requested via E-Mail.

4. Mit Zahlung des einmaligen Nutzungsentgeltes erwirbt der Anwender lediglich das
Nutzungsrecht im Sinne dieser Nutzungsbedingungen. Das Eigentum am Handbuch verbleibt
uneingeschrankt beim Autor.

5. With one-time payment of the remuneration of utilisation of the user acquires only the right of
use for the purposes of this Terms of use. The ownership of the manual fully remains with the
author.

6. Any commercial user will receive a VAT invoice.
V. Copyright Infringement

1. Any copyright infringement will be prosecuted. The author, a lawyer will always help. Be
asserted in the context of provisional legal protection - if necessary - injunctive-, information- and
claims for damages.

2. A copyright infringement is if the manual with criminal content by the users or by third parties.
The author is displayed next to the assertion of civil claims immediately after having regard to
criminal report.

3. Responsible in the sense of the UrhG and these terms and conditions, in addition to the owner
of the company or the industry for non-existing persons identity of the creator of the website
using this book is offered for download or in any other manner.

4. Information about the legality of a planned use of the book given by the author. The contact
data the author can bee seen in the imprint on the web page.
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VL. Liability

UPYRIGHT The author assumes no liability whatsoever, regardless of the legal grounds, arising out of the

use and/or the use of the book or in any other way in connection with the acquisition,
exploitation and use of the book could be deducible, except in cases of intent or gross

ENERAL negligence.

ERMS ND The brand names used in this manual are registered trademarks of their respective owners.

ONDITIONS

>
o
(=]
L9
o0
®
o
c
]
L
<

PO Table of contents © 2013-2024 CIMSoft, @pps4Me Page 27




	Table of contents
	Açana @B Copy What is AçaNa @bCopy?
	What is «Açana @bCopy» ?
	Açana @B Copy Start Application
	Start Application
	Açana @B Copy Operation Of Açana @BCopy
	Operation of «Açana@bCopy»
	Açana @B Copy Touch Bar
	Touch Bar
	Açana @B Copy Copy A Contact To  Clipboard
	Copy a Contact to Clipboard
	Açana @B Copy Copy ALl Contacts  To  Clipboard
	Copy all Contacts to Clipboard
	Açana @B Copy Copy SELECTED Contacts  To  Clipboard
	Copy selected Contacts to Clipboard
	Açana @B Copy Drag And Drop A Contact
	Drag and Drop a Contact
	Açana @B Copy Share A Contact
	Share a Contact
	Açana @B Copy Switch Copy Feature
	Switch Copy Feature
	Açana @B Copy Filter Contacts
	Filter Contacts
	Açana @B Copy Reload Address Book
	Reload Address Book
	Açana @B Copy Export As XLSX File
	Export as XLSX File
	Açana @B Copy Export As Csv File
	Export as CSV File
	Açana @B Copy Export As Csv File
	Açana @B Copy Export As Csv File
	Açana @B Copy Preferences
	Preferences
	Açana @B Copy Help Menu
	Help Menu
	Açana @B Copy Share A  Link To  This App
	Share a Link to this App
	Açana @B Copy More Apps From  @pps4Me
	More Apps from @pps4Me
	Açana @B Copy Contact  To Us
	Contact to Us
	Açana @B Copy Copyright  & General Terms and Conditions
	Copyright & General Terms and Conditions
	Açana @B Copy Copyright  & General Terms and Conditions
	Açana @B Copy Copyright  & General Terms and Conditions

